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Overview of Exercise
The purpose of this exercise is to examine the capabilities of the ArcGIS 9.2 desktop
GIS software and use these concepts to construct a functioning shoreland management
GIS application “from scratch” using primarily local government-generated spatial data.
The GIS application that will be developed as part of this exercise is focused on Blue Lake
in northwest Oneida County near Minocqua, Wisconsin. The three sections of the
exercise include:
1. Import and integration of the local government spatial data used in the exercise;
2. Analysis of assessed value and property ownership patterns around the lake;
3. Review and analysis of shoreland zoning regulations impacting the lake;
The GIS software functionality that will be utilized includes data import and integration,
image interpretation, linkage of attribute data with spatial data sets, thematic mapping,
spatial query and analysis, customizing graphical user interfaces, incorporating external
programs (scripts), and inter-application connectivity. The Shoreland Management GIS
training exercise reinforces concepts learned in the Introduction to ArcView training
course developed by Environmental Systems Research Institute (ESRI) of Redlands,
California.
Acknowledgments
Much of the background information on lake management and rural zoning in Oneida
County was extracted from a DNR Lake Protection Grant proposal for shoreland zoning
compliance assessment prepared by Oneida County staff. Bryan Pierce, the Vilas County
UW-Extension CNRED Agent and John Czarnezki, formerly the Oneida County
UW-Extension CNRED Agent both provided information on shoreland zoning concerns in
the northern lakes district. The spatial data sets used in the application come from a
variety of sources. Planimetric and parcel data were obtained from Mike Romportl, the
Oneida County Land Information Officer. Another version of the parcel map was
digitized by staff of the Land Information and Computer Graphics Facility (LICGF) from
paper maps. Digital wetland maps were obtained from the Wisconsin Department of
Natural Resources. Digital orthophoto quarter quads (DOQQs) were produced by the
U.S. Geological Survey and obtained from the Ken Lubich in the Madison office of the
Natural Resource Conservation Service. Digital raster graphs (DRGs) were obtained
from Lance Perry in the BIM/GEO section of the Wisconsin Department of Natural
Resources and represent another U.S. Geological Survey product. The tax roll, sanitary,
and permit attribute files were provided by Lynn Grube of the Oneida County Data
Processing Department. The septic tank point data set was created specifically for the
exercise to show an example of septic system maintenance notification and is completely
fictitious. Photo images of Blue Lake were taken in October 1996 by David Hart of
UW-Madison LICGF. Finally, a digital copy of the Oneida County Zoning and
Shoreland Protection Ordinance was obtained from John Czarnezki and developed into a
Windows help file using RoboHelp 3 from Blue Sky Software of LaJolla, California.
The desktop GIS software utilized in this exercise, ArcView 3.1, is a product of
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Environmental Systems Research Institute (ESRI) of Redlands, California.
Background
Oneida County is part of the northern temperate lakes district of Wisconsin and
Michigan, a region characterized by one of the highest concentration of inland lakes in the
world. Oneida County contains 426 named and 701 unnamed lakes. The total surface
area of the county is 779,235 acres. Of this, 74,415 acres (10.5 percent) is water.
Important research in the early development of the field of limnology was conducted in
the region and the area is known as the “cradle of limnology.”
Development Pressures. Development in Oneida County has increased over the
past several decades. There has been a boom in construction of both seasonal
recreational homes and permanent residences. The number of new building permits has
increased from 1,112 in 1989 to 1,643 in 1993. A total of 825 new sanitary permits were
issued in 1993, up from 557 in 1989. Much of the new construction activity has taken
place on lakefront property. Of the single family homes constructed in 1993, 52 percent
were on lakefront properties. The 1990 census indicates that 11,263 of 25,173 total
housing units in the county (45 percent) are seasonal. Developable lakefront property is
becoming scarce and, as a result, shoreside property values have risen dramatically.
Commercial development is also active in Oneida County. The county is a major
tourism destination, with over 300 lodging facilities offering approximately 3200 rooms;
37 campgrounds with over 1500 total campsites; and seventeen recreation camps serving
approximately 2,800 people. Lodging occupancy information and visitors surveys
indicate that Oneida County serves an average summer seasonal population of over 55,000
people, which is almost double the 1990 permanent population of 31,679.
The History of Rural Zoning in Oneida County. In May 1933, Oneida County
enacted the first comprehensive rural zoning ordinance in the United States. In the early
1930’s, most northern Wisconsin counties were facing financial difficulties stemming, in
part, from difficulties in converting cut-over forest lands to agriculture. The purpose of
the rural zoning ordinance was to restrict settlement in remote areas. The Oneida County
Board of Supervisors was concerned about the high costs of transporting school children
and the construction and maintenance of roads in remote areas. The ordinance eventually
became a model for other counties in Wisconsin and promoted the creation of county
forest preserves across northern Wisconsin.
Since that time, the nature of zoning in rural Oneida County has changed. The
County adopted a Shorelands Protection Ordinance in November 1970 based on state
enabling legislation. The ordinance has since been revised several times. It is now
identified as the Oneida County Zoning and Shorelands Protection Ordinance.
Amendments to the ordinance include provisions on mining, signage, non-conforming
structures, and placement of mobile and manufactured homes.
Protecting Water Quality and Aesthetics. Given the increasing development
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pressure in the county and the fact that much of the new development is located on the
county’s fragile lake ecosystems, regulation of shoreland development is very important.
Failing septic systems, construction site soil erosion, runoff of lawn fertilizers, and other
sources represent non-point sources of pollution that impair water quality. Water quality
impairment threatens fish and wildlife habitat and aesthetics. Various structural
violations of the shoreland ordinance requirements may also threaten the water quality and
natural beauty of the lake resources.
To address these concerns, Oneida County has initiated a comprehensive revision of
the zoning and shoreland protection ordinance. The overall goals of the project are to
improve compliance rates of new and existing shoreland development, and to protect
shoreland and lake ecosystem quality. Funding for the multi-year effort comes from local
sources and a state lakes protection grant. The scope of the project includes: (1) an
assessment of shoreland zoning compliance and resource problems; (2) revision of mining
provisions in shorelands and floodplains; (3) comprehensive revision of the zoning and
shoreland protection ordinance to improve its administration; (4) community education on
the revised regulations; and (5) creation of a program to monitor and enforce the revised
ordinance.
Spatial Information Technologies for Enforcement of Shoreland Zoning. Oneida
County has an active land records modernization program and is exploring methods to
incorporate GIS/LIS technology to assist in administration and enforcement of the zoning
and shoreland protection ordinance. Specific activities include creation of digital parcel
maps, development of parcel identification numbers (PINs) to link property attributes to
the parcel map, development of digital orthophotos on a regular time frame, incorporation
of aerial or boat-based videography to help detect property changes and zoning violations.
Oneida County has contracted with the Land Information and Computer Graphics Facility
(LICGF) at the University of Wisconsin-Madison to provide technical assistance, database
development, and training to support develop a GIS-based monitoring system for
long-term enforcement and evaluation of the ordinance.
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Section 1. Data Input and Integration
Estimated time: 45 minutes
In this section, you will start a new ArcMap document, input a variety of spatial data sets,
including buildings, hydrography, parcels, scale-corrected aerial photographs
(orthophotos), and scanned USGS topographic maps (digital raster graphics), and
manipulate the appearance and properties of these data sets. All your data sets should be
on the C drive in a subdirectory named c:\coastgis\bluelake.

Create an ArcMap Document.
Start the ArcMap program by double clicking the ArcMap icon on the computer desktop
or by selecting the ArcMap program from the ArcGIS programs folder in the Start menu.
At the start-up dialog box, chose to start using ArcMap with a new empty Map.
From the File pull-down menu, choose Document Properties… type in your name as the
Author and fill in other information of the map document.
From the View pull-down menu, choose
Data Frame Properties… In the Data
Frame Properties dialogue box, click
General tab, and change the name from
“Layers” to “Data Integration Frame.”
Then click Coordinate System tab. In
the Select a coordinate system box,
click Predefined item to expand the sub
items. Click Projected Coordinate
Systems, County Systems, and then
Wisconsin CRS item. Choose “NAD
1983 HARN Wisconsin CRS Oneida
(US feet)” coordinate system (the data
are in Oneida County Coordinates which
is a coordinate system based in feet).
Click OK. Note the change in your
ArcMap window.
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From the File pull-down menu, choose Save. Navigate to the c:\coastgis\bluelake
subdirectory and save the map file as “bluelake.mxd”. Click OK.
An ArcMap document file is assigned the extension “.mxd”. An ArcMap document can contain
multiple data frames, database tables, and a map layout. For this shoreland management training
exercise, all of your work will be saved in a single ArcMap document. Remember to save your work
frequently. Use the disk button on the far left side of the interface. If your computer crashes, and you
have recently saved your document, it will be very easy to return to where you left off simply by
opening the document. If you do not frequently save your project and the computer crashes, you will
lose any changes made since your last save.

Add Feature Data Files to the Data Frame.
Click the Add Data button to add data files as layers into your Data Frame. In the
Add data dialog box, for Data Source type, make sure Datasets and Layers is
selected. Navigate to the c:\coastgis\bluelake subdirectory. Locate and highlight the
following data files. You can select multiple data files by holding the “Ctrl” or “Shift” key
while making your selection. When all the files listed below are selected, click OK.
1. Bl_water.shp (hydrography polygons)
2. Bl_parcl.shp (parcels polygons)
3. Bl_bldgs.shp (building outlines polygons)
The data files are ESRI shapefiles(*.shp) located in the c:/coastgis/bluelake subdirectory (or in the
alternate subdirectory specified by the instructor). Many different formats of spatial data may be
imported into ArcMap, including ArcINFO coverages, AutoCAD DXF and DWG files, and
Intergraph files.

Once the data files have been inserted into the Data Frame. Make sure each of the layers is
visible by clicking on the box in front of each layer.
A layer is the name given to a spatial data file imported into ArcMap. Layers are displayed in the
View based on the order they appear in the Table of Contents (i.e. layers on the top of the Table of
Contents are displayed over the other layers in the View). To change the display order of layers, click
on the layer name to make it active and drag it to a new position on the Table of Contents. The active
layer is the layer that is “selected” (a blue background rectangle) in the Table of Contents. It is
important to note which layer is active, as many ArcMap functions are performed on the active theme.

Reorder the layers in the Table of Contents to place Bl_bldgs at the top of the Table of
Contents, followed by Bl_water, and Bl_parcl.
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Modify Layer Properties.
Make the Bl_bldgs (building outlines) layer active. When a layer is first created, it is
displayed in a random color. This color can be changed. You can change individual layer
symbols by changing the Symbology of layer properties. You will change the symbology
to make the buildings red. In the Table of Contents, right-click on bl_bldgs and click
Properties… to bring up the Layer Properties dialog box (a short-cut is to double click on
the layer in the Table of Contents).
To change the color, first click the Symbology tab. In Show box, make sure the Single
symbol sub item of Features is selected. Click the big color button in the Symbol frame.
This brings up the Symbol Selector (a short-cut is to double-click on the symbol for the
bl_bldgs layer). Choose an appropriate bold shade of red from the scrolling box on the left,
which contains predefined symbols. Or define your own symbol by changing the Options
and Properties… Click OK in the Symbol Selector dialog box and Layer Properties
dialog box.
It is often important to change the name of a layer to have it describe more clearly the
information you are displaying in the View. We will use layer properties to change the
layer name to “Buildings.” In the table of contents, right-click on Bl_bldgs layer and click
Properties… In the Layer Properties dialog, click the General tab. To rename the layer,
highlight the Layer Name input box and type in “Buildings”, then click OK. otice that the
new layer name is now displayed in the Table of Contents.
Make the Bl_water (hydrography) layer active. In some cases, we will want to only
display a subset of the spatial features in a particular layer. In this case, there is an island in
Blue Lake that should not be displayed as water. You will use layer properties to build a
query to select only where ‘land_wat = W’ and to change the layer name to “Water.” You
can define selection criteria using the Query Builder to display a subset of the theme
features.
In the Table of Contents, right-click on Bl_water and click Properties… You are now in
the Layer Properties dialog box and you want to build a query that selects a subset of the
‘water’ layer.
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In the Layer Properties dialog box, click Definition Query tab, and then press the Query
Build… button. In the Query builder, from the
Fields list, double-click “Land_Wat” -- this
now appears in the expression box. Next, you
want to set this equal to a value (click once on
the ‘=’ sign). Click Get Unique Values button.
From the Unique Values list, double click
‘W’ to set the expression equal to ‘water.’
Click OK on the Query Builder. Before
exiting Layer Properties dialog, click General
tab, and change the Layer Name to ‘Water’.
Click Symbology tab to make the water blue.
Click OK. Close out of Layer Properties
dialog box. Note that when the map view is
re-drawn, only those features which are water
are displayed.

Make the Bl_parcl (parcels) layer active. The parcel data set includes lakes and other areas
that have not been assigned a parcel identification number. We will want to exclude these
from the layer.
Use the Query Builder in Definition Query page in Layer Properties to build a query to
select only the parcels where the field Parcel_id is not equal to “Blue Lake”, “Papkee
Lake”, or a blank value. The query should read (“Parcel_id” <> ‘Blue Lake’) and
(“Parcel_id” <> ‘Papkee Lake’) and (“Parcel_id” <> ‘’). Note: ‘<>‘ denotes “not equal
to.” When the query is entered correctly (as in the figure below), click OK.

While in Layer Properties, change the layer
name to “Parcels.”
Use the Symbol Selector to make the parcels
light gray.
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While in the Data Integration Frame, use the measurement tool to examine the
distance across the lake in different directions. The measurement tool utilizes the
distance units set in Data Frame Properties. The distances are displayed at the bottom left
of the ArcMap status bar. To stop measuring, double-click in the View or press Esc on
your keyboard. For your information, Blue Lake is approximately 445 acres in size.
As mentioned previously, it is always a good idea to save your project on a regular
basis. Now is a good time.

Add Image Data Files to the Data Frame.
The buildings, water, and parcels datasets are termed feature data sources in ArcMap.
Feature data sources are made up of points, lines, and polygons, and are often referred to
as vector data in the GIS lingo. ArcMap can also import image data. Image data are made
up of arrays of “pixels” (picture elements) or “grid cells”. In this section, you will import
digital orthophotos (scale-corrected aerial photographs) and Digital Raster Graphs
(scanned USGS 7.5’ topographic maps). The image files are in the TIFF file format (*.tif)
with a TIFF world file (*.tfw) to give information about the placement of the image with
reference to the Oneida County coordinate system.
Choose the Add Data icon. Choose blueedoq.tif, bluewdoq.tif, blueedrg.tif and
bluewdrg.tif (hold the shift key
down to select both files at the
same time). Click Add. If ArcMap
pops up a dialog asking you to
create pyramids for the image files,
click Yes and let it create pyramids.
Pyramids allow for rapid display at
varying resolutions.
Drag the newly added themes to the bottom of the table of contents if they are not in the
bottom and make the Building, Water, and Parcels layer invisible (uncheck the box in
front of the layer). Make the bluewdoq.tif layer visible.
Zoom into the bay in the northwest corner of Blue Lake. Select the Zoom In icon.
Make a box around the bay by pointing to the upper left corner of the bay and
holding down the left mouse button to draw a box to the lower right corner of the bay.
Note the features in the bay. Note the black linear feature on the west side of the bay and the radial fan
pattern in the center of the bay. Any ideas what might cause that? (It might help if we knew the date of
the photography.) Make the Building layer visible. Can you see any buildings that are not included in
the Building layer? Can you be sure they are buildings? Note what appears to be a dock on the north
shore of the bay. Digital orthophotos make an interesting backdrop for the feature (vector) data.
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The Zoom To Layer function in the right-click menu of a layer in the Table of Contents
can be used to zoom the View to the extent of the selected layer. Right-click on the
bluewdoq.tif layer and click on the Zoom To Layer.
The Digital Raster Graphs (DRGs) are a product of the US Geological Survey. They are
scanned versions of the 7.5’ topographic quads. They are often several years out-of-date,
based on the most recent revision of the topo sheet.
Make the bluewdrg.tif and bluewdoq.tif layers visible and all other layers invisible. Make
sure the bluewdrg.tif layer is on top of the bluewdoq.tif layer in the Table of Contents.
Double-click on the bluewdrg.tif layer to activate the Layer Properties Dialog. Click
Symbology tab. In Show box, select Unique Values. Double-click on the following DRG
symbols (0,1,2,3,5,6,7,8) to make them transparent (change the color to No Color) and
change the color of value 4 to bright yellow. When finished, click Apply in the Layer
Properties dialogue box. This allows contour lines to be displayed in bright yellow over
the digital orthophoto. You have created a “quick and dirty” contour map and can better
visualize the topography of the area. Explore how the contours look at different map scales.
Manipulating digital orthophotos and DRGs can create many interesting maps that can be
used for assessment of development around lakes at the regional scale.

Click OK to close the Layer Properties dialogue box.
Make the Building, Water, and Parcels layers visible and all other layers invisible.
The Full Extent button can be used to zoom the View to the extent of all layers.
Click on the Full Extent button.
Time to save your document. As you go along, saving your document should become
second nature.
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Section 2. Thematic Mapping of Parcel Attributes
Estimated time: 45 minutes
In this section, you will join tax roll data to the parcel map through the use of a unique
parcel identification number (PIN). You will then be able to display and analyze patterns
of assessed value and property ownership.

Create a new Data Frame.
You will create a new Data Frame for this section. From the Insert pull-down menu,
choose Data Frame. A New Data Frame will be created in the bottom of the Table of
Contents and the view will become empty. Make sure the New Data Frame is active by
choosing activate in the right-click menu of the frame. Use Data Frame Properties…
from the view pull-down menu (or the right-click context menu of the frame) to change
the name to “Tax Roll Data Frame” and set the map coordinate system to “NAD 1983
HARN Wisconsin CRS Oneida (US feet)”.
You can copy and paste layers between Data Frames, preserving the colors and properties
of the original layer. In the ArcMap Table of Contents, select the Buildings, Water, and
Parcels layers in the Data Integration Frame.
In order to make multiple layers selected, simply hold down the “Ctrl” or “Shift” key and select each
layer. All selected layers should be highlighted.

Right-click on one of the selected layers. On the context menu, click Copy. In the Table of
Contents, right click on the Tax Roll Data Frame. On the context menu, click Past
Layer(s). Click the minus sign in front of the Data Integration Frame to collapse the layers.
You will only use the Tax Roll Data Frame in this section. Make sure the Tax Roll Data
Frame is active.

Join the Tax Roll database to the Parcels layer.
For each layer added to a data frame, there is an associated attribute table with descriptive
information. You will begin by examining the existing attributes of the Parcels layer. In
the Table of Contents, right-click the Parcels layer and click Open Attribute Table.
When the table opens, scroll through the table, and review the fields.
Close the Parcels table.
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Next, you will need to add the tax roll database file to the ArcMap document. On the
standard toolbar, click the Add Data button. In the Add Data dialog, navigate to
c:\coastgis\bluelake and select the taxroll96.dbf, then click Add. The taxroll96 table is
added to the table of contents.
When a table is added to a map, the tab at the bottom of the table of contents switches from Display to
Source, showing tables and paths to layers.

In the table of contents, right-click the taxroll96 table and click Open. When the table
opens, take a moment to scroll through the table and review the fields.
One of the more useful capabilities of desktop GIS is the ability to view and analyze the spatial
patterns of information stored in relational databases. A “join” is a way to match and append records
between two tables through a common identifier. In performing the join operation, the taxroll96.dbf
file will be your source table, and the Attributes of Parcel table will be your destination table.

Close the taxroll96 table. In the table of
contents, right click on the Parcels layer.
On the context menu, point to Joins and
Relates, and then click Join… A Join Data
dialog will pop up. In the drop-down list at
the top of the Join Data dialog, make sure
“Join attributes from a table” is selected. In
drop-down list number 1, click the
drop-down arrow and click PARCEL_ID.
This specifies PARCEL_ID as the common
attribute in the Parcels Table. In drop-down
list number 2, click the drop-down arrow
and click taxroll96. In number 3, click the
drop-down arrow and click PARCEL_ID.
This specifies PARCEL_ID as the common
attribute in the taxroll96 table. Click OK.
Finally, the taxroll96.dbf source table is
now “dynamically” joined with the
Attributes of Parcels destination table.

Before opening the Parcels table, you should remove the Definition Query of the Parcels
layer (from Layer Properties), because there is a bug in ArcMap.
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After empty the Definition Query, in the table of contents, right-click the Parcels layer and
click Open Attribute Table. Note the fields in the joined table.

Display Assessed Value of the Land from the Tax Roll Database.
Close the Attributes of Parcels table. Make sure the Tax Roll Data Frame is active.
Double-click the Parcels layer to open the Layer Properties dialog. Click the Symbology
tab.
In the Show box, click Quantities, and then choose Graduated Color. In the Fields
frame, click the Value drop-down arrow and click taxroll96.TOTAL_LAND. In the
Classification frame, click Classify… button to open the classification dialog. Make sure
Natural Breaks (Jenks) is selected in
Method drop-down list and change the
Classes to 4. In Data Exclusion frame,
click Exclusion… button to open the Data
Exclusion Properties dialog. The Query
page is displayed in default. In the text box,
enter the query statement as
("taxroll96.TOTAL_LAND" = 0 ) OR
( "taxroll96.TOTAL_LAND" IS
NULL ) to exclude those data. Click
Legend tab, check the box in front of
Show symbol for excluded data. Click
the symbol button to change the color to
black. Fill in “No Data” to Label text box
and click OK button to close the Data
Exclusion Properties dialog and
Classification dialog.
In Layer Properties dialog, click General
tab and change the layer name to Assessed
Value of Land. Click OK to close it.
The no data values in black represent either a zero value in the tax roll database or where a match
could not be made between the tax roll database and the Attributes of Parcels table. What could cause
matching problems between the two files? Some possibilities could be typographic errors in the
unique parcel identification number or subdivision activity that splits or combines parcels and assigns
them new PINs. If the digital parcel map and/or the tax roll database are not kept up-todate, the
number of matching errors is likely to increase.
Note: There is another bug in ArMap of ArcGIS Desktop 9. The map view doesn’t display the parcels
whose taxroll96.TOTAL_LAND value is Null. Only parcels with value 0 are displayed. To solve
this problem, you can build a query in Definition Query to show all parcels. But avoid using the
PARCEL_ID field, which was utilized as the join key. For example, “bl_parcel.FID > -1”. Then the
parcels will be displayed correctly.
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Right click on the Assessed Value of Land layer and click Copy. Paste it into the Tax Roll
Data Frame to make a copy of the layer. Make one of the two copies active. Use Layer
Properties to rename the Layer to “Assessed Value of Land/Area”. Make this layer visible,
while turning off the visibility of the “Assessed Value of Land” layer.
Double-click on the “Assessed Value of Land/Area” layer to invoke the Layer Properties
dialog. Click Symbology tab. In Field frame, modify the Normalization drop-down list
to “bl_parcel.Area”. Click OK to close the Layer Properties dialog and compare the
differences between the two parcel layers.
Note that many of the large parcels that have a high total assessed value of land are in the lowest
category when you examine assessed value per square foot. Also note that the assessed value of the
land seems to be highly dependent on the amount of lake frontage. Finally, note that what appear to be
fairly similar lakefront parcels on the island actually span a range of assessed values of land per
square foot.

Display Out-of-State Ownership from the Tax Roll Database.
From the right-click context menu on the layer, use Copy and Past Layer(s) to make a
copy of the Assessed Value of Land layer. Change the layer name of the copy to
“Property Ownership”. Make the two Land Value layers invisible. Make the new
“Property Ownership” layer active and invoke the Symbology page in Layer Properties
dialog. In the Show frame, select Categories and click Unique Values. Select
“taxroll96.State” from the Value Field drop-down list.
Click Add Values button, select “WI” from the list box in Add Values dialog and click
OK. Click Add Values button again, choose “IL” and click OK.
In Symbology page in
Layer Properties dialog,
double-click the symbol
in front of the <all
other values> item and
change the color to light
green. Make sure the
box in front of the
symbol is checked.
Change the symbol
color of “IL” to pink
and the symbol color of
“WI” to gray.
Click Apply and OK
button to close the
dialog.
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From Selection pull-down menu, click Select
By Attributes… Select Property Ownership
in the Layer drop-down list. Change Method
to Create a new selection. The zip code for
the Blue Lake area (Minocqua, Wisconsin) is
‘54548’. Develop a query ("taxroll96.ZIP" =
'54548') to select all those parcels where the
tax bill is sent to the local zip code. Click on
Apply then close the window. You could
assume that most of these are permanent
residents on Blue Lake. The selected parcels
are outlined in cyan.

Do you notice any patterns about ownership on the lake? The eastern side of the lake tends to have
more out-of-state ownership, while there is more in-state ownership on the western side of the lake.
There also seem to be clusters of Illinois residents in certain locations on the lake.

From Selection pull-down menu, click Clear Selected Features to clear the selection.
Save the document again.
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Section 3. Spatial Analysis of Shoreland Zoning Regulations
Estimated Time: 30 minutes

Part 1. Waterline Setbacks
You will create a new data frame for this section. If you are in the Tax Roll Data Frame,
select the Insert pull-down menu and choose Data Frame. An empty map screen will
appear. If not, activate the frame by right-clicking the frame and choosing Activate. Use
data frame Properties… to change the name of the new created data frame to “Shoreland
Regulations Frame” and set the map Coordinate System to “NAD 1983 HARN Adj WI
Oneida Feet” (look at section 1 if you forget). Under Tax Roll Data Frame, select
Buildings, Water, and Property Ownership layers. Right-click on one of these three
layers, and click Copy. Click the minus sign in front of the Tax Roll Data Frame to
collapse it. Now right click on the Shoreland Regulations Frame, and click Paste
Layer(s).
Double-click on the Property Ownership layer to invoke the Layer Properties dialog
and click Symbology tab. In the Show box, select Features and click Single symbol.
Change the symbol color to light gray. Click General tab, and change the layer name to
Parcels.

Find all the Buildings within 75 feet of the Shore.
The Oneida County Zoning and Shoreland Protection Ordinance specifies a waterline
setback of 75 feet for most structures, in most cases. To determine which structures are
within 75 feet of the shore, we will use the Select By Location command. The Select By
Location command creates a new set of features from a layer (the target layer) based on
their relationship to another layer (the selector layer). In the Selection menu, choose
Select By Location… You are now in the Select By Location dialog box. In the first
drop-down list, choose select features from and check the box in front of the Buildings
layer (this is the target layer). Select are within distance of in that drop-down list (the
second drop-down list). Choose Water layer (this is the selector layer) in the features in
this layer drop-down list (the third drop-down list). Enter 75(feet) for the selection
distance. Click Apply. Close the dialog.
Notice that all of the buildings that are within 75 feet of the water are now outlined in cyan.
You may need to zoom in to see this.
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Find Parcels that Contain the Selected Buildings.
There is not much information tagged to buildings, but there are many attributes tied to
parcels (e.g. property owner mailing address, site address, and assessed value). In this case,
the target layer is set Parcels. As previous example, in the Selection menu, choose Select
By Location. Make sure select features from is selected in the first drop-down list.
Check Parcels layer (the target layer), and uncheck the other layers. In the second
drop-down list you want to select Intersect. Next, select Buildings (the selector layer) in
the third drop-down list and check Use selected features under the drop-down list. Click
Apply and close the dialog.
Now, both the parcels and buildings are selected. You can right-click on the Buildings
layer in the table of contents, point to Selection and click Clear Selected Features.
Notice that now the parcels are outlined in cyan. What happens when a structure encroaches on a
neighboring parcel? Contemplate what impact errors in spatial data can cause in administration of the
shoreland zoning ordinance.

Next, we will save the selected features of
parcels as a new layer. Right-click on the
Parcels layer in the table of contents. In
the context menu, point to Data and click
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Export Data… In Export Data dialog, choose Selected features in Export drop-down
list and choose Use the same Coordinate System as this layer’s source data. Fill in the
file name with full path as “C:\Coastgis\BlueLake\nonconf1.shp” in the text box. Click
OK. Select Yes when prompted to add the exported data to the map as a layer. Choose
Clear Selected Features from the Selection pull-down menu. Change the name of the
new layer to Nonconforming for Waterline Setback.

Part 2. Lot Size
The Oneida County Zoning and Shoreland
Protection Ordinance specifies a minimum
lot size of 20,000 square feet for
unsewered lots, in most cases. To
determine which parcels fall short of this
standard, we will use the Select By
Attributes command. Choose Select By
Attributes from the Selection pull-down
menu. In the dialog, select Parcels in
Layer drop-down list and choose Create a
new selection in Method drop-down list.
From the Fields list, double-click
"bl_parcl.AREA" -- this now appears in
the expression box. Next, you want to set
to a value “less than” 20,000 square feet
(click once on the ‘<‘ sign). Then, type in
20000 right after the ‘<’ sign. Click Apply
and close the dialog.

Again, we will save the selected features of parcels as a new layer. Right-click on the
Parcels layer in the table of contents. In the context menu, point to Data and click Export
Data…In Export Data dialog, choose Selected features in Export drop-down list and
choose Use the same Coordinate System as this layer’s source data. Fill in the file
name with full path as “C:\Coastgis\BlueLake\nonconf2.shp” in the text box. Click OK.
Select Yes when prompted to add the exported data to the map as a layer. Choose Clear
Selected Features from the Selection pull-down menu. Change the name of the new layer
to Nonconforming for Lot Size.
Compare the two new layers. Are there any lots that are both nonconforming for waterline setback
and lot size?
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Evaluation Form

What were the strengths of the Blue Lake Shoreland Management GIS Exercise?

What were the weaknesses of the Blue Lake Shoreland Management GIS Exercise?

How could this GIS training exercise be improved?
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